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1.0 Introduction 

In 1994 the Federal Geographic Data Committee (FGDC) was established by the Office of 

Management and Budget Circular A-16. Composed of representatives from many government 

agencies, the objective of the FGDC has been to promote “the coordinated development, use, sharing, 

and dissemination of geographic data.”
1
 Federal Geographic Data Committee. Washington, D.C., p.ii available 

online: http://www.fgdc.gov/metadata.) In June of 1998, the FGDC released the Content Standard for Digital 

Geospatial Metadata which has become the national standard for geospatial metadata.    

Since 1994, several free and commercial products have been introduced which facilitate the creation of 

FGDC compliant metadata including ESRI’s ArcCatalog™.  ArcCatalog™ is part of a suite of GIS 

creation and management tools developed by Environmental Systems Research Institute (ESRI). 

ArcCatalog™ is able to auto-generate and display some metadata by reading the digital file, but is not 

able to generate supporting descriptive text such as abstracts, purpose statements, or supplemental 

information. Metadata can be created in ArcCatalog™ for a variety of resources including images, 

documents, geospatial and tabular data. 

This manual details the creation of FGDC compliant geospatial metadata using ArcCatalog™, 

including an explanation of the data properties generated automatically by the software versus those 

which must be completed manually. The following sections are presented in order of the 

ArcCatalog™ metadata entry screens. FGDC Content Standard for Digital Geospatial Metadata 

section numbers are included in parentheses ( ). Required fields are indicted in red.    

 

 

                                                 
1 Federal Geographic Data Committee. FGDC-STD-001-1998. Content standard for digital geospatial metadata (revised 

June 1998). 
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Figure 1 - ArcCatalog™ Metadata Preview Window 

2.0 ArcCatalog™ Structure 

 

Figure 2 - ArcCatalog™ Metadata Toolbar 

 

 

A metadata record, an .xml file, is automatically created in ArcCatalog™ when you highlight a file in 

the tree on the left and click on the ‘Metadata’ tab on the right. The record is empty except for the 

fields that are automatically generated by the ArcCatalog™ program. These fields include: 

 

• Native Data Set Environment (Windows and Arc Catalog version numbers)  

• Native Data Set Format (shapefile, Arc Info coverage, text file, etc.)  

• Language (defaults to en – English)  

• Citation Title (defaults to file name)  

• Geospatial Presentation Form (file type - vector digital data, document, document, etc.)  

• Online Linkage (defaults to network path)  

• Spatial Domain (bounding coordinates if coverage or shapefile is projected)  

• Direct Spatial Reference Method (under Data Organization – point, raster or vector)  

• Spatial Reference (projected coordinate system)  

• Entity and Attribute Types (Entity Type lists the .pat, .aat, and any other info files along with 

the individual attribute labels)  

• Metadata Standard Name (defaults to ‘FGDC Content Standards for Digital Geospatial 

Metadata’)  

• Metadata Standard Version (defaults to current Arc Catalog Metadata version)  

• Metadata Time Convention (defaults to ‘local time’)  

• Metadata Date (defaults to entry date)  

• Metadata Language (defaults to en – English)   

 

 

Edit Metadata 

Import Metadata 

Export Metadata 
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You can then open the metadata record and fill in all other appropriate information by clicking on the 

‘Edit Metadata’ button. 

 

 

 

 

Figure 3 - ArcCatalog™ Metadata Toolbar – Edit Metadata 

 

The metadata editor has multiple tabs organizing the information into various groups. Some tabs have 

addition tabs within them. This document will provide a step-by-step walk through with a real data set, 

(Digital Database of Faults from the Fault Activity Map of California and Adjacent Areas California; 

Department of Conservation, Division of Mines and Geology) giving examples of what is required or 

recommended for each entry. Required fields are indicated in red.    

 

 

3.0 General Identification 

The general identification section includes explanatory text and a description of access or use 

limitations associated with a given data set. 

Abstract: A brief text summary of the data set. (FGDC p. 4) 

Purpose: A summary of the intentions for which the data set was developed. (FGDC p. 4) 

Supplemental Information: Other descriptive information about the data set. (FGDC p. 4) 

Access Constraints:  Restrictions and legal prerequisites for accessing the data set. These 

include access constraints applied to assure the protection of privacy or intellectual property, 

and special restrictions or limitations when obtaining the data set. If there are no access 

constraints, enter "None." If access constraints cannot be determined, do not enter any 

information. (FGDC p.7) 
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Use Constraints: Restrictions and legal prerequisites for using the data set once access is 

granted. These include use constraints applied to assure the protection of privacy or intellectual 

property, and special restrictions or limitations in using the data set. If there are no use 

constraints, enter "None". If use constraints cannot be determined, do not enter any 

information. (FGDC p.8) 

Data Set Credit: The original source of GIS data, author and agency of the report from which 

the GIS data was created, and you or your agency if you created or altered the GIS data in any 

significant way (FGDC p. 8). Language, Native Data Set Environment, and Native Data Set 

Format are all generated by the ArcCatalog™ program.  

 

 

 

Figure 4 - ArcCatalog™ General Identification Screen 
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3.1 Contact 

The contact information section provides information for communicating with the individual or 

organization that is knowledgeable about the data set. This person or organization must be able to 

answer questions about the data and be responsible for updates if there are errors in the data. The 

contact person should be the individual that provided the data set or the person who made significant 

changes once the data was received. (FGCD p.58-60) 

 

 

 Person, Organization, Position: Name, organization, and title of individual to contact. 

 For consistency with bibliographic references, it is recommended that you use ‘last name, first 

 name’ format. 

 Voice Telephone & Fax Number: Should include area code and international access 

 number if applicable. 

 Hours of Service: If used, should specify time zone (i.e. 8:00 am – 4:00 pm PST). 

 State & Country: Use accepted US Postal abbreviations (i.e. CA, US). 

 

 

Figure 5 - ArcCatalog™ Point of Contact Screen 
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Figure 6 - ArcCatalog™ Contact Details Screen - General 

 

Figure 7 - ArcCatalog™ Contact Details Screen - Address 
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3.2 Citation 

The citation section defines how the data originator should be specified, similar to that of a 

bibliographic citation in the reference section of a book. (FGDC p. 53-55) 

 Title: ArcCatalog™ automatically sets the title to the name of a data set, but this should be 

 replaced with a short, more descriptive title.  

 Originator: The name of an organization or individual that developed the data set. For 

 consistency with bibliographic references, it is recommended that you use ‘last name, first 

 name’ format. 

Publication Date: Although GIS data is not usually published in the normal sense, the 

publication date is the day the data is made available for release. The date can be either a  year, 

a year and a month, or a year, month and day entered in the following format: YYYYMMDD 

(for example 19840621 for the date June 21, 1984). The publication date can also be 

"Unknown" or "Unpublished material”. 

 Online Linkage defaults to the file path of the data set. If the data is available online for 

 download, this should be changed to the web link. 

 Geospatial Presentation Form: For GIS data, ArcCatalog™ automatically sets this field to be

 raster or vector digital data, and should be changed as necessary. 

Series/Publication Information: If the data is part of a series, such as the tiles in a larger data 

set, fill in the appropriate information. 

 
Figure 8 - ArcCatalog™ Citation Title Screen 
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Figure 9 - ArcCatalog™ Citation Details 

 

 

 

 

Figure 10 - ArcCatalog™ Citation Details, Series/Publication Information 



Redlands Institute Manual for Creating Metadata in ArcCatalog
TM

 

 

11 

3.3 Time Period of Content 

The time period of content is considered to be the timeframe associated with the data set. This 

information explains how current the data is. (FGDC p. 56-57) 

 

Currentness Reference: This can be "ground condition”, which is when an aerial photo was 

taken or when the field work was accomplished. Sometimes, only the time the information was 

recorded or published is known. In these cases, specify "publication date" for the currentness 

reference.  

 

Calendar Date: Dates should be in the format YYYYMMDD (for example, “19870306” can 

be used for the date March 6, 1987). Dates can also be recorded as “Unknown.” 

 

 

 

 

Figure 11 - ArcCatalog™ Time Period Screen 
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3.4 Status 

The status section provides the progress and maintenance information for the data set. (FGDC p.4) 

  

 Progress: Choices are Complete, In Work, and Planned. 

 Update Frequency: Multiple choices for data update frequency. 

 

 

 

 

Figure 12 - ArcCatalog™ Status Screen 
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3.5 Spatial Domain  

The FGDC standard requires the geographic extent of the data be described using latitude and 

longitude values. If the data is projected, the coordinate system must be defined in order for 

ArcCatalog™   to automatically generate latitude and longitude values. Bounding coordinates are the 

western-, eastern-, northern-, and southern-most coverage limits of a data set, as expressed in latitude 

and longitude values. These should not be changed. (FGDC p. 5) 

 

 

 

 

Figure 13 - ArcCatalog™ Spatial Domain Screen 
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3.6 Keywords 

Keywords are subjects or topics covered by the data set.  They are used as a reference to search a 

document or data set. A Thesaurus is a book or collection that lists words related to each other in 

meaning or to a particular subject, usually giving synonyms and antonyms. 

 

 

 Thesaurus: Specify whether or not the keywords have been selected from a formal thesaurus 

 or a similar authoritative source of theme keywords. If not, type "None" for thesaurus. 

 

Theme Keywords: Themes should describe the subject of the data, such as rock formation or 

geology. 

  

 Place Keywords: Place keywords describe the geographic location of the data, such as Mojave 

 Desert or Death Valley National Park.  

 

Stratum Keywords: Stratum keywords describe the vertical location of the data, such as 

seafloor or stratosphere.  

 

Temporal Keywords: Temporal keywords provide a time reference for the data, such as 

Mesozoic or Civil War.  

 

 

Figure 14 - ArcCatalog™ Keyword Screen 
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3.7 Browse Graphic  
 

The browse graphic is a thumbnail illustration of the data set. The graphic should include the graphic 

file name representing the data, a text description of the data, and the type of graphic file. (FGCD p. 8) 

 

 

 

 

Figure 15 - ArcCatalog™ Browse Graphic Screen 
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3.8 Security Information (FGDC p.9) 
 

The security section refers to restrictions on handling of the data set, which can be imposed for any 

number of reasons, including but not limited to national security, privacy, or other concerns. Provide 

the name of the security classification system, the security classification and a description of the 

handling restrictions of the data set. Most often, data is unclassified and the security system is ‘none’. 

 

 

 

 

Figure 16 - ArcCatalog™ Security Screen 
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3.9 Cross Reference 

This category of information concerns other related data sets, reports, images, etc., that are of 

importance to the data set. (FGDC p. 53-55) 

 Title: Title.  

 Originator: The name of an organization or individual that wrote or developed the related data 

 or document. For consistency with bibliographic references, it is recommended that you use 

 ‘last name, first name’ format. 

Publication Date: Although GIS data is not usually published in the normal sense, the 

publication date is the day the data was made available for release. The data can be either a  

year, a year and a month, or a year, month and day, entered in the following format: 

YYYYMMDD (for example, “19660227” can be used for the date February 27, 1966).The 

publication date may also be "Unknown" or the reference may be "Unpublished Material”. 

Online Linkage: If the data is available for online download, this entry should be changed to 

the web link. 

Geospatial Presentation Form: This field identifies the way the data is represented 

geospatially (i.e. raster or vector digital data, map, model, globe, etc.) 

Series/Publication Information: If the cross reference is part of a series, fill the information 

into the appropriate fields. 

 

Figure 17 - ArcCatalog™ Cross Reference Screen 



Redlands Institute Manual for Creating Metadata in ArcCatalog
TM

 

 

18 

 

Figure 18 - ArcCatalog™ Citation Details Screen 

 

 

Figure 19 - ArcCatalog™ Citation Details Screen, Series/Publication Information 
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4.0 Data quality 

The data quality sections provide consistency and accuracy information for the data set. (FGDC p. 12-

15) 

 Logical consistency: This field indicates the topological integrity of the data. 

Polygon  - Polygon and chain-node topology present. All polygons are closed; every polygon 

has a label, and only one label point. 

 

Points – Point features present. This is point data, and it has been reviewed for positional 

accuracy, and accuracy of the attribution. There is no topology to examine. 

 

Lines - Arc-node topology present. 

Shape files do not have topology; skip the Logical Consistency window for such files. 

Completeness:  Omission, selection or generalization criteria, definitions  used, and other rules 

implemented to generate or derive the data are listed in this field. (For example: The data set 

has no generalization, and no data was intentionally omitted.) 

Cloud cover: Cloud cover need only be listed for satellite imagery and aerial photography. It is 

expressed as a percentage of the area obstructed by clouds. For vector digital data, use “N/A” 

(not applicable).  

 

Figure 20 - ArcCatalog™ Data Quality Screen 
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4.1 Attribute Accuracy 

Attribute Accuracy: This screen is an assessment of the accuracy of the attribute values in the data set 

(FGDC p. 11). (For example, the data set has been reviewed and is considered to be 99% accurate.) 

 

Figure 21 - ArcCatalog™ Attribute Accuracy Screen 

 

 

4.2 Positional Accuracy  

Positional accuracy is an assessment of the precision of placement of spatial objects and is a 

combination of both horizontal and vertical accuracy descriptions. (FGDC p. 12-13) (For example, the 

data set is estimated to be accurate +/- 120 feet.) 

 

Horizontal Accuracy Report: This is an estimate of the precision of horizontal positioning of 

spatial objects. 

 

Vertical Accuracy Report: This is an appraisal of the precision of vertical positioning within 

the data set. 
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An example of a Horizontal Positional Accuracy Report is:  

 

Estimated to be +/- 40 feet (for data at 1:24,000) 

 - USGS Topo Quads and data derived from them 

 

Estimated to be +/- 160 feet (for data at 1:100,000) 

 - USGS Topo Quads and data derived from them 

 - USGS DLG Line work 

 - US Census Bureau TIGER line files 

 

Estimated to be +/- 400 feet (for data at 1:250,000) 

 - USGS Topo Quads and data derived from them 

 

Estimated to be +/- 800 feet (for data at 1:500,000) 

 - USGS Topo Quads and data derived from them 

 

Estimated to be +/- 1650 feet (for data at 1:1,000,000) 

 - ESRI’s DCW data 

 

Estimated to be +/- 3300 feet (for data at 1:2,000,000) 

 - USGS National Atlas data 

 

Estimated to be +/- 8250 feet (for data at 1:5,000,000) 

 

Figure 22 - ArcCatalog™ Positional Accuracy Screen 
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4.3 Source Information 

This section provides a list of sources and a short discussion of the information contributed by each. 

(FGDC p. 13-14). 

 

Source Scale Denominator: The denominator of the representative fraction on a map (for 

example, on a 1:24,000-scale map, the Source Scale Denominator is 24000).  

 

Type of Source Media: The medium of the source data set (i.e. paper, online, etc.).  

 

Source Citation Abbreviation: Short-form alias for the source citation. 

 

Source Contribution: Brief statement identifying the information contributed by the source to the 

data set. 

 

 

 

 

Figure 23 - ArcCatalog™ General Source Information Screen 
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Source Citation The citation section defines how the data source should be specified, similar to that of 

a bibliographic citation in the reference section of a book. 

 Title: Title.  

 Originator: The name of an organization or individual that wrote or developed the source data 

 or document. For consistency with bibliographic references, it is recommended that you use 

 ‘last name, first name’ format. 

Publication Date: Although GIS data is not usually published in the normal sense, the 

publication date is the day the data was made available for release. The data can be either a  

year, a year and a month, or a year, month and day, entered in the following format: 

YYYYMMDD (for example, “19660227” may be used for the date February 27, 1966). The 

publication date can also be "Unknown" or the reference can be referred to as "Unpublished 

Material”. 

Online Linkage: If the data is available for online download, this reference should be changed 

to the web link. 

Geospatial Presentation Form: This information identifies the way the data is represented 

geospatially (i.e. raster or vector digital data, map, model, globe, etc.) 

 Series/Publication Information: If a cross reference is part of a series, the appropriate 

 information must be completed. 

 
Figure 24 - ArcCatalog™ Source Citation Screen 
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Time Period of Content This screen retains the timeframe associated with the data set. This 

information explains how current the data is. (FGDC p. 56-57) 

 

Currentness Reference: This can be "ground condition", which is when an aerial photo was 

taken or field work was done. Sometimes, only the time and date the information was recorded 

or published is known. In these cases, provide the "publication date" for the currentness 

reference.  

 

Dates should be in the format YYYYMMDD (for example, “19571225” can be used for the 

date December 25, 1957). Dates can also be recorded as “Unknown.” 

 

Figure 25 - ArcCatalog™ Source Time Period of Content Screen 

 

4.4 Process Step 

This section provides an explanation of the steps taken in constructing the data. Multiple process steps 

should be note and can be added with the small + button at the bottom of the screen. Each process step 

should include the process step contact if known. (FGDC p. 14-15) 

An example of a process step entry is provided below. 

 

Process Step #1 - This data set was created by scanning the 

1:750,000-scale mylar overlays of the faults shown on Jennings 

(1994) using ARC/INFO software.  Scanning, vectorization, and 

initial editing of the Quaternary faults were done by Richard Dart 
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and Michael Machette of the U.S. Geological Survey in Denver.  

Additional editing was done by Diane Burns and Geoffrey Faneros 

of the Division of Mines and Geology (CDMG) in Sacramento.  

The pre-Quaternary faults were digitized by Geoffrey Faneros and 

Jason Little of CDMG.  The late Cenozoic faults in the Foothills 

Fault Zone are included with the pre-Quaternary faults and were 

digitized by Jennifer Davis of CDMG.  George Saucedo and David 

Wagner of CDMG did proofing of both the initial and final editing. 

 

Process Step #2 - Data downloaded by Redlands Institute, 

University of Redlands staff from an online linkage. Files unzipped 

and imported as necessary. Projection checked against project 

standards and reprojected if needed. Topology and attributes QA'd. 

 

Dates should be in the format YYYYMMDD (for example, “19961123” could be used for the date 

November 23, 1996). 

 

 

Figure 26 - ArcCatalog™ Process Step Screen 
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4.4.1 Process Contact 

 

In this section, the contact information for the individual or organization responsible for each step in 

creating the data set is recorded. This individual should be able to answer questions about the 

processing or procedures performed. (FGDC p. 58-60) 

 Person, Organization, Position: Name, organization, and title of individual to contact. For 

 consistency with bibliographic references, it is recommended that you use ‘last name, first 

 name’ format. 

 Voice Telephone & Fax Number: Should include area code and international access 

 number if applicable. 

 Hours of Service: If used, should specify time zone (i.e. 8:00 am – 4:00 pm PST). 

 State & Country: Use accepted US Postal abbreviations (i.e. CA, US). 

 

 

 

 

Figure 27 - ArcCatalog™ Process Step Contact Details Screen - General 
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Figure 28 - ArcCatalog™ Process Step Contact Details Screen - Address 
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5.0 Data Organization 

This section provides spatial data organization information (FGDC p16).  ArcCatalog™   

automatically completes the information in this section, and this data should not be changed. 

 

 

 

 

Figure 29 - ArcCatalog™ Data Organization Screen 
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6.0 Spatial Reference  

If the data projection and coordinate system has been defined, ArcCatalog™   automatically completes 

all entries for this section.  This should also not be changed. (FGDC p. 19-36) 

 

Figure 30 - ArcCatalog™ Spatial Reference Screen 
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7.0 Entity Attributes 

ArcCatalog™   automatically completes certain entity attribute fields.  (FGDC p. 37-41) 

Data Set Overview – This is a summary of the information content of the data set. 

Entity and Attribute Overview: This is a more detailed summary of the information 

contained in the data set (FGDC p. 41).  

 

For example, LTYPE might be line type; Line Types are recorded in the LTYPE Field: (on 

land) solid - well located; dashed - approximately located or inferred; dotted - concealed; 

(offshore) solid - well defined; dashed - inferred. LVALUE might be another line type; Line 

Values are also recorded in the LVALUE Field: 1 - solid; 2 - dashed; 3 - dotted. AGE – age of 

the fault  

 

Entity and Attribute Citation: This section contains the bibliographic citation or agency 

information which is the source of the attributes and their values. 

 

 

 

 

Figure 31 - ArcCatalog™ Entity Attribute Overview Screen 
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7.1 Attribute Descriptions and Values 

ArcCatalog™   automatically adds all the entity types (.aat, .pat, etc.) and their attributes to the 

metadata. Definitions for each attribute and a source for each definition must be provided. (FGDC p. 

37-41) 

 

Figure 32 - ArcCatalog™ Entity Attribute Detail Screen -Entity Type 

 

 

For an ArcInfo coverage, there can be many ‘entities’, such as an .aat (arc attribute table) and a .pat 

(point attribute table). Within an “.aat”, there are many attribute fields, such as LTYPE, LVALUE, and 

AGE. Each attribute must have a definition and source. Examples are provided in the following: 

 

LTYPE - line type 

Line Types Recorded in the LTYPE Field: 

 

(on land)  

solid - well located;  

dashed - approximately located or inferred;  

dotted - concealed;  

 

(offshore)  

solid - well defined;  

dashed - inferred.   
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LVALUE - line value 

Line Values Recorded in the LVALUE Field:  

1 - solid;  

2 - dashed;  

3 - dotted. 

AGE – age of fault  

 

 

 

 

Figure 33 - ArcCatalog™ Entity Attribute Detail Screen – Attribute General 
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Attribute Domain Values 

A description of the numeric values contained by each attribute must also be provided. There are four 

categories of values: enumerated, range, codeset, and unrepresentable.  

Enumerated Domain:  This domain is used to describe a list of values. For example, there 

might be 15 different types of roads. Each value should be listed in the metadata along with a 

definition of the value and the source of that definition.  

Range Domain: This one is comprised of a sequence, series, or scale of (usually numeric) 

values between known limits. For example, the attribute age might have a range domain of 

integers from 0 to 100. The minimum and maximum values must be provided, as well as the 

source. 

Codeset Domain:  This is a domain in which the data values are defined by a set of codes. 

Examples include the Federal Information Processing Standards that contain numeric codes for 

nations as well as states and counties in the United States. The title of the publication 

containing the code set and the source of the codeset should be provided.  

Unrepresentable Domain: This type is a domain in which the set of data values cannot be 

represented. Reasons include attributes whose values do not exist in a known, predefined set 

(for example, the values of an attribute based on people's names), or attributes whose values 

cannot be depicted using standard forms of representation (not in available character sets, etc.). 

In these cases, the information content of the value sets should be provided.  

 

Figure 34 - ArcCatalog™ Entity Attribute Detail Screen – Attribute Values 
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8.0 Distribution 

This section provides information about the distributor of and options for obtaining the data set. 

(FGDC p. 42-49) 

 

 

 

 

Figure 35 - ArcCatalog™ Distribution Screen  
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9.0 Metadata Reference 

This section provides contact information for the individual or organization who wrote the metadata. 

The person or organization should be able to answer questions about the metadata and be responsible 

for updates if there are errors found in the metadata. (FGDC p. 50-52) 

  

 ArcCatalog™   automatically fills in Metadata Date, Metadata Standard Name, Metadata 

 Standard Version, Metadata Time Convention, and Language of Metadata fields.  
 

Metadata Access Constraints and Metadata Use Constraints: This includes all restrictions 

and legal prerequisites for accessing and using the metadata, which should normally be ‘none’. 
 

Metadata Security Information: This includes handling restrictions imposed on the metadata 

due to national security, privacy, or other concerns.  

 

Metadata Security Classification System: This refers to any restrictions on handling of the 

metadata, which can be imposed for any number of reasons, including but not limited to 

national security, privacy or other concerns. This is normally ‘none’. 

 

Metadata Security Classification: This would include the type or security class applied to the 

metadata, and is normally ‘Unclassified’. 

 

 

Figure 36 - ArcCatalog™ Metadata Reference Screen  
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Person, Organization, Position: This field includes the name, organization and title of an 

individual to contact. For consistency with bibliographic citations, it is recommended that you 

use the ‘last name, first name’ format. 

Voice Telephone & Fax Number: This information includes an area code and international 

access  number when applicable. 

 Hours of Service: If used, a time zone should be specified (i.e. 8:00 am – 4:00 pm PST). 

 Address Type and Address: Fill in the address and if the address is the physical address, 

 mailing address, or both. 

City: List the city which applies to the address. 

 Postal Code: Use either the five or nine digit postal zip code. 

State and Country: Use accepted US Postal abbreviations (i.e. CA, US) when utilizing this 

field. 

Dates should be in the YYYYMMDD format (for example, “19840621” would be used for the 

date June 21, 1984). 

 

 

Figure 37 - ArcCatalog™ Metadata Contact Details Screen - General 
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Figure 38 - ArcCatalog™ Metadata Contact Details Screen - Address 
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10.0 Importing and Exporting Metadata in ArcCatalog™ 

If you receive data with a metadata file, either an .xml or text file, this metadata can be imported into 

ArcCatalog™ providing it is in the proper format. (If not, you will have to copy and paste from the 

original document into ArcCatalog™). Metadata can also be exported in various formats to share with 

others.  

10.1 Importing Metadata 

1. Click on the file for which you want to import metadata.  

2. Click the Metadata tab.  

3. Click the Import Metadata button  on the Metadata toolbar.  

4. Click the Format dropdown arrow and then click the format of the metadata to be imported.  

5. Click the Browse button.  

6. Navigate to and click the metadata file whose contents are to be imported. Click Open.  

7. Click OK.  

The imported metadata will appear in the Metadata screen. 

10.2 Exporting Metadata  

1. Click on the file for which you want to export metadata.  

2. Click the Metadata tab.  

3. Click the Export Metadata button  on the Metadata toolbar.  

4. Click the Browse button. 

5. Navigate to the folder in which the exported metadata resides; type a name for the new 

metadata file, and then click Save.  

6. Click the Format dropdown arrow and click the format in which the metadata is to be 

exported.  

7. Click OK.   

A new file containing a copy of the item's metadata is created.  

11.0 Thumbnails 

1. Click the coverage or shape file for which a thumbnail is to be generated.  

2. Click the Preview tab. 

3. Click the Preview dropdown arrow on the Preview tab, and then click Geography.  

4. Click the Zoom In button  on the toolbar and zoom to an area best representing the 

layer's contents, or zoom out to the full extent of the data.  

5. Click the Create Thumbnail button . 
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12.0 Spell Checking Metadata  

ESRI offers many Arc Objects™ macros online. These include tools and extensions that allow the 

customization of a variety of functions within many ESRI products. The spell check function for 

metadata is certainly one of the more useful of these tools.   

To download the spell check tool, follow either of the two web links indicated below. 

http://arconline.esri.com/arcobjectsonline/    samples, metadata, tools, Metadata, SpellChecker 

Metadata SpellChecker 

To add the spell check function to ArcCatalog™, click on the Tools dropdown list and then click 

Customize. Click the Toolbars tab and click ‘add from file’. Find the “MDSpell.dll” downloaded 

earlier and click ‘open’.  

Once the SpellChecker function has been added to ArcCatalog™, this tool will be accessible every 

time ArcCatalog™ is opened. To change the button image, click on the Tools dropdown menu and 

then click Customize. With the Customize window open, right click on the SpellChecker button (the 

default should be a wrench icon). Go to Change Button Image and pick a different one.  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 39 - ArcCatalog™ Customize Toolbars Screen 
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Figure 40 - ArcCatalog™ Change Button Image Screen 

 

 

To spell check metadata, select a file in the tree on the left that has metadata, click the metadata tab on 

the right and click the Spellcheck Metadata button. A Microsoft Word document is generated with all 

the metadata elements that aren't automatically updated by ArcCatalog™, and that don't contain 

numbers, dates, or thumbnails. Each value will be checked for spelling errors using Word's default 

dictionary settings. If a spelling error is found, the offending word can be corrected using Word's 

Spelling and Grammar dialog box. Any words that are changed will be updated in the ArcCatalog™ 

metadata document once the dialog is closed. 
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13.0 Stylesheets 

The ArcCatalog™ program provides a variety of stylesheets to 

view your metadata. The following pages show the various types 

of stylesheets and the data that is shown on each. All the text that 

is entered is saved to the .xml file, which is shown as well, but 

not all styles provide a complete record.  

13.1 FGDC Classic Stylesheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 41 - ArcCatalog™ FGDC Classic Stylesheet 
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13.2 FGDC Stylesheet 

 

Figure 42 - ArcCatalog™ FGDC Stylesheet 
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13.3 FGDC ESRI Stylesheet 

 

Figure 43 - ArcCatalog™ FGDC ESRI Stylesheet 
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13.4 FGDC Geography Network Stylesheet 

 

Figure 44 - ArcCatalog™ FGDC Geography Network Stylesheet 
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13.5 ISO Stylesheet 

 

Figure 45 - ArcCatalog™ ISO Stylesheet 
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13.6 ISO Geography Network Stylesheet 

 

Figure 46 - ArcCatalog™ ISO Geography Network Stylesheet 
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13.7 XML Stylesheet 

 

Figure 47 - ArcCatalog™ XML Stylesheet 

 


